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1 Introduction 
 

TeamDrive enables the fast, easy and secure exchange of data between two or more computers. Once TeamDrive 

is installed you can create Space folders from scratch, or convert existing folders into Space folders, in as little as 

three mouse clicks. Your files and folders remain in your file system and can be opened and edited as usual. 

Meanwhile, TeamDrive automatically: 

� Creates encrypted backups of the monitored Space folders on the Internet. 

� Synchronizes all (shared) data with the other invited Space members. 

� Saves older versions of edited files (file versioning). 

� Encrypts files as they are transferred and saved. 

As a TeamDrive member you have the choice of creating your own Spaces and deciding whether or not to invite 

others to join them. You also have the choice of joining Spaces that you are invited into. Additionally, you can syn-

chronize data across multiple computer platforms (Windows, Mac OS X and Linux) and/or mobile devices (iOS and 

Android) on which you are using a TeamDrive client registered under the same username. 

2 Installation and Registration 
 

In order to install TeamDrive your computer will need to meet the minimum system requirements. You will need 

at least 250MB of free disk space, a valid email address and Internet access. In the end, the total amount of disk 

space used will depend on the size of your created and/or joined Spaces. 

2.1 System Requirements 

WINDOWS MACINTOSH LINUX 

 

1 GHz Processor 

Windows XP/Vista/7/8 

 

512 MB RAM 

250 MB free disk space 

 

Internet connection 

Details can be found on the 

TeamDrive Windows forum 

 

Intel Mac 

10.6 (Snow Leopard) or newer 

 

1 GB RAM 

250 MB free disk space 

 

Internet connection 

Details can be found on the 

TeamDrive Mac forum 

 

1 GHz x86 Processor 

KDE, GNOME 

 

512 MB RAM 

250 MB free disk space 

 

Internet connection 

Details can be found on the 

TeamDrive Linux forum 

 

You will also need a valid email address for registration and activation. 

If you have any further questions, you can find answers on the TeamDrive website in the FAQ section or on the 

TeamDrive Forum. If you are experiencing problems installing or using TeamDrive please contact our Support 

Team. 

To install or update TeamDrive please download and run the installation software. 

Img. 1: The installation of TeamDrive can be started by double-clicking the application icon 

http://forum.teamdrive.net/viewforum.php?f=17
http://forum.teamdrive.net/viewforum.php?f=11
http://forum.teamdrive.net/viewforum.php?f=12
http://www.teamdrive.com/support.html
http://forum.teamdrive.net/index.php
mailto:support@teamdrive.com?subject=TeamDrive%20Support%20Request
mailto:support@teamdrive.com?subject=TeamDrive%20Support%20Request
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Note: 

If you are installing TeamDrive for the very first time, an Internet connection is required to register. If you are an 

existing TeamDrive member, an Internet connection is also required to activate the client. 

 

If it is your first time installing and using TeamDrive you will need to create a TeamDrive account. TeamDrive can-

not be used without an account. To create an account, you will need to enter a desired username and password. 

The username must be at least five characters long and may not contain any special characters or spaces. The 

password must be at least eight characters long and may contain special characters, but no spaces. 

2.2 TeamDrive Installer 

After you have successfully downloaded TeamDrive, double-click the TeamDrive installation file to start the instal-

lation. Once the TeamDrive installer opens you will be able to install TeamDrive. For more help on installing 

TeamDrive, please refer to the tutorial videos on our website.  

 

2.3 TeamDrive Recommended Practices 

You should not use TeamDrive to synchronize databases. A database is usually stored in a file, which means that 

TeamDrive would have to transfer the entire file each time a data record was changed, which would lead to in-

creased traffic and memory consumption on the server. 

Avoid deeply nested directory structures. The operating system-specific restrictions on paths and file names also 

result in restrictions for TeamDrive users. 

          Microsoft Windows: 

              - Maximum length of the entire directory path: 247 characters 

              - Maximum length of file names: 259 characters 

          Linux: 

              - Maximum length of a path section: 255 Bytes 

              - Maximum length of a file name: 254 Bytes 

          OSX: 

              - Maximum length of a path section: 255 Bytes 

              - Maximum length of a file name: 255 Bytes 

 

 

CAUTION: 

If you share a Space with members with different operating systems, please observe the limits stated on file names 

in order to guarantee cross-platform compatibility. 

 

 

https://www.teamdrive.com/handbooks_and_tutorials.html
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NOTE: 

The lengths specified in Bytes are based on the fact that Unicode is used in these file systems. Consequently, the 

maximum lengths depend on the characters used. As a rough guideline: 

              - A standard alphabet character (a-z, A-Z) = 1 Byte 

              - An extended alphabet character (German umlauts etc.) = 2 Bytes 

Avoid storing all your data in just one Space. By granulating your Spaces more finely, it will be easier to control 

who has access to which data. This also reduces the need to re-sort files. 

Do not move your Spaces to other drives or partitions; instead, use the "Recover Space" function. If you must 

store your Space on another hard drive or partition, choose "Space" > "Recover Space" in the TeamDrive Explorer 

and specify the new storage location. 

Do not move your Space manually across partition or drive boundaries, as this could result in the loss of 

TeamDrive synchronization data because all meta information is re-created and it is then no longer possible to 

track which file was edited for the last time and when. 

Avoid using special characters in file names and paths. It may be that these characters will not be supported on a 

different platform. 

3 First Steps 
 

3.1 Registering, Entering a Provider Code and Logging In 

After starting TeamDrive you will see the options “I am already a TeamDrive user” and “I am new to 

TeamDrive”. Below these two options is a field where you can enter a Provider Code. As an existing user you can 

enter your provider code if you know it. If you do not know your Provider Code it is enough to simply click “Con-

tinue” and log in. Your Provider Code will automatically be recognized via your login credentials.  

If you are a new user registering for the first time or registering with a new username it may be essential, depend-

ing on your case, that you enter a Provider Code. 

The Provider Code determines your provider of TeamDrive Services. This includes the Registration Service (where 

your username, password and email address are stored) and your default TeamDrive Cloud Storage. 

You must specify a Provider Code in two cases: 

- You are using TeamDrive for the first time and you wish to select a particular Service Provider. In this case, 

you can obtain the Provider Code from your Service Provider’s Website. 

- You would like to use TeamDrive Services provided by a Corporate IT Department. In this case, ask your 

System Administrator for the Provider Code. 

 

If you register without specifying a Provider Code, TeamDrive Services will be provided by TeamDrive Systems 

with storage in the European Cloud (enter TDUS for the North American Cloud). 

 

After registering your username please be sure to activate your account via the activation link sent to your regis-

tered email address. After clicking the activation link confirm in TeamDrive that you have clicked the activation link 
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and login on the following screen. 

 

 
 

Registering, entering a provider code and logging in 

 

3.2 Monitoring Folders (Creating Spaces) 

After installing TeamDrive, creating a user account and logging in, the TeamDrive Explorer will start in the “Spac-

es” view. In order to share files and/or work together with someone in a Space, you will first need to create or join 

a Space. To create a Space, click “Create Space” on the toolbar (you can also navigate through the file menu by 

selecting “File” > “Create Space...”). 

 
 

Click “Create Space” to open the Space Wizard and create a Space 

 

On the first page of the SpaceWizard, you will need to decide whether you wish to create a new Space or convert 

an existing folder on your computer into a Space. If you create a new Space a new folder will be created within the 

Spaces directory on your computer. 

Note: A Professional license allows you to create or store a Space on a network drive with a UNC path, 

e.g. ‘\\dss\...\server\share\...’.  

If you would like to convert an existing folder into a Space simply select it from your file system or network drive. 
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Space Wizard Step 1: Create a new Space or 

select an existing folder to convert into a Space 

Space Wizard Step 2: Enter a Space name 

 

With a TeamDrive Professional license you also have the ability to select how many versions are stored on the 

server. There are proposed values of 1, 3, 5, 10 and unlimited. You also have the ability to enter a custom number 

of versions to be stored on the server. To do so, highlight “unlimited” and either erase the proposed value or just 

start to enter a value. The value you enter will be saved in the settings file of the client and remain as a selectable 

option for future Spaces you create. 

  
  

Space Wizard Step 3: Select number of 

versions to be stored on the server 

Space Wizard Step 4: Select the server to host the Space on 

 

You also have the ability to select where the Space shall be hosted. “Server” allows you to select whether to use 

your default TeamDrive storage depot, a WebDAV server or a TeamDrive Personal Server. If you have not yet add-

ed a WebDAV or TeamDrive Personal Server, you may do so here. 

After entering a name for your Space, click “Next” to create the Space. A summary detailing the Space name, loca-

tion and server name will be displayed. At this screen it is also possible to invite users to your newly created Space. 
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The new Space will now be displayed in the TeamDrive Explorer. To locate the Space in your file system, right-click 

on the Space and select “Show in File System”.´ 

  
  

Space successfully created Space displayed in file system (Windows) 

 

3.3 Inviting Users and Accepting Invitations 

To invite other users into a Space select the desired Space in the TeamDrive Explorer and click “Invite Members” 

on the toolbar. Alternatively, right-click on the Space and select “Invite Members...”. 

 
 

Invite a user 

 

Using the Invitation Wizard you can invite users via their username OR their email address (you DO NOT need to 

enter both the username and email address on the same line). Enter the user’s username or email address into the 

input field and click “Add”. The Space you are inviting users to will also be displayed in the top-left corner of the 

Invitation Wizard. If you have changed the name of the Space locally you will have the option to choose which 

Space name the invitee receives. They will not know your local name you have chosen for the Space unless you 

invite them to the Space using the local name.  
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Add a user to invitation list 

 

You can then set the user’s privileges within the Space, enter an invitation message (or use the generic one creat-

ed by TeamDrive) and optionally password protect the invitation. Password protecting invitations is useful in cases 

where you are unsure of a user’s username, you are inviting a user via their email address or you simply want to 

add more security to you Space invitation. Users will not be able to join the Space without first entering the re-

quired password. You may invite multiple users at once. 

 
 

Set user rights 

 

To complete the invitation process click “Invite Users”. 
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Complete invitation process and invite the user 

 

 

Note: 

Non-TeamDrive members are invited to join Spaces, and TeamDrive, via emails that could potentially be inter-

cepted by malicious third parties. Members sending invites are therefore advised to confirm the email addresses of 

non-TeamDrive members before sending invitations. In addition, the “password protect the invitation” feature is 

a viable option for encrypting invitations. Using a password will also help to prevent unintentional invitees, possi-

bly due to misspelled usernames or email addresses, from joining a Space. 

The invited user will receive a Space invitation notification via email and a Space invitation within the TeamDrive 

client. Space invitations can only be accepted or declined via the client. Within the Space invitation notification 

email are links to download TeamDrive installation software; for use in case TeamDrive is not already installed on 

the recipient’s machine.  

When a Space invitation is received, the “Invitation List” icon on the toolbar will display a red asterisk. Before ac-

cepting the invitation you have the opportunity to rename the Space folder, select a new path where the Space 

shall be saved and select whether you would like to download all file versions or only the current versions of files. 

The available options depend on the license type (Free, Personal or Professional). You will have the option to: 

“download current version only”, “download all versions” or “download directory information only” (Profes-

sional license only). 
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Accept an Invitation: Selecting the Space path Accept an Invitation: Select Space join mode 

 

Lastly, before finally accepting the invitations and joining the Space, if the files contained in the Space you are 

about to join already exist on a local or external drive TeamDrive can copy or move the files from that location to 

the new location where the Space will be joined.  More information on this method of joining a Space can be 

found in section “Joining (or Recovering) a Space”. 

 
 

Accept an Invitation: Copy or move Space data from an alternate location 

 

Once the Space invitation has been accepted, the files will begin to sync.  

 

3.4 Inviting Yourself to Your Previously Created Spaces 

If you have just installed a TeamDrive client on a new machine and are wondering why you are unable to see 

Spaces you have already created/joined, it is important that you invite yourself to your previously created/joined 

Space(s). Via your existing TeamDrive client installation, right-click on the Space you wish to invite yourself to (or 
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highlight all of your Spaces and right-click on them) and select “Invite All My Devices”. An invitation will then be 

sent to all of your currently activated TeamDrive clients. 

 
 

“Invite All My Devices” 

 

Alternatively, you can use the backup files from a previous TeamDrive installation to import and restore access to 

your Spaces, and their server settings, on a new TeamDrive client installation. More information on restoring Spac-

es can be found in the section “Restoring and Activating a Space”. 

Backup files can also be imported from the Key Repository if you have this function turned on. By default, this 

feature is turned on. More information on the Key Repository can be found in the section “Key Repository”. 

You can also invite yourself to your Spaces using the TeamDrive app for mobile devices. 

 

3.5 Joining (or Recovering) a Space 

3.5.1 How-to: Join/Recover a Space without having to re-download all of the data from 
the server (i.e. the data already exist locally on the machine) 

 

In many cases, when joining or recovering a Space, the data already exist locally on your hard drive, on a flash 

drive, external hard drive, etc. This can also be the case when one master account has created Spaces, uploaded 

data and would like to share this data with their friends, colleagues or coworkers without them having to down-

load all of the files from the server. In an office of 20-30 people, everyone downloading the same amount of data 

at once may put some strain on the network, especially if the files are big. To ease this process TeamDrive allows 

users, when joining or recovering a Space, to alert TeamDrive to the fact that the data already locally exist. You can 

then have TeamDrive copy or move the data from this location to the new location where the Space will be stored. 

First, users need to be, of course, invited into the Space (if the Space is being recovered from a backup file, the 

backup file(s) need(s) to be imported). When joining or recovering a Space, the data can be downloaded com-

pletely from the server, restored from the existing Space folder on your machine (if the Space is being recovered) 

or copied or moved from any other existing folder on your local machine or an external hard drive. To view and 

select one of these options click the “Advanced” button in the “Space Invitation”/“Recovery” window. You will 

then see a drop down menu with the options, “copy files from backup” (if you are recovering the Space), “copy 
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files from specified path”, and “move files from specified path”. Select the desired option, and file path if nec-

essary, and click “Accept”/“Recover”. 

  
Join Space via invitation Join Space via restore/recover 

 

TeamDrive will then compare the local versions of the data with the latest versions on the data on the server. If the 

versions match, the local data will be copied or moved to the Space. If the versions do not match, the versions 

from the server will be downloaded. 

 

3.5.2 How-to: Join a Space that already exists locally on your machine or in TeamDrive’s 
database. 

 

There exist different scenarios where you may attempt to join a Space and TeamDrive tells you “Space already 

exists”, “The Space folder already exists” or “Space folder already exists”. 

 

“Space already exists” lets you know that this particular Space ID already exists in the database. This can be the 

case for different reasons, e.g. multiple users share a single TeamDrive installation and are trying to join the same 

Space with their respective accounts, a single user with multiple TeamDrive accounts is trying to join the same 

Space with multiple accounts, a user with only one account deleted the Space in the file system, and not via 

TeamDrive, and is trying to join the Space, etc. To get passed this error message and be able to successfully join 

the Space, the Space needs to be deleted in the TeamDrive database. 

An easy way is to uninstall and re-install TeamDrive. This will then, of course, clear all Spaces from the database 

and all Spaces will have to be rejoined. This is, yes, an easy way but not the most desirable. Instead, the user who 

joined the Space on that respective machine needs to log in and delete the Space via TeamDrive. The Space will 

then be removed from the database and other users will be able to join the Space on that machine. If the Space no 

longer appears in TeamDrive when the necessary user logs in, this user needs to first restore the Space and then 

delete it. It is not necessary to rejoin the Space completely. You can start the recovery/join process and then select 

“Cancel Joining a Space (Archiving a Space while Joining)”. 
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It is also possible to use a portable installation of TeamDrive to allow multiple users to join the same Space on the 

same machine. It is possible to achieve this with a portable installation because the TeamDrive database for a 

portable installation is stored in a different location as the database of the standard TeamDrive installation. 

 
 

“Space already exists” 

 

“The Space folder already exists” and “Space folder already exists” let you know that there is a folder or Space, 

in the directory where you are attempting the save the Space, with the same name. This can occur if you delete a 

Space via TeamDrive and elect not to delete the Space folder locally, if you are migrating data from one computer 

to another by copying the Spaces folder from computer 1 to computer 2 etc. (section “How-to: Join/Recover a 

Space without having to re-download all of the data from the server (i.e. the data already exist locally on the ma-

chine)”). You can either rename the existing folder in that directory, save the Space you are joining to a different 

directory or rename the Space you are joining. 

 
 

“Space folder already exists” 
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3.6 Cancel Joining a Space (Archiving a Space while Joining) 

While joining a Space it is possible to cancel the join process. This will actually archive the Space and allow you to 

recover the Space at your earliest convenience. To cancel joining a Space, right-click on the Space during the join 

process and select “Cancel joining Space…”. This option, however, will not become available until the events of 

that Space have begun to be downloaded. Once TeamDrive has begun downloading the folder’s events from the 

log, it is possible to cancel joining the Space. 

 
 

“Cancel joining Space…” 

 

3.7 Relocating and Renaming a Space Folder 

3.7.1 Relocating a Space Folder 
Relocating a Space folder is a simple and straightforward process. To move a Space folder, first you need to shut 

down the TeamDrive client. After the client has been shut down, move the Space folder to the newly desired loca-

tion in the file system and start TeamDrive after that. 

Upon starting, TeamDrive will recognize that the location of a Space folder has changed and will ask you for the 

new location of the Space folder. Browse to the new location of the Space folder, select it and that’s it! 

Your Space folder has now been relocated.           

 

3.7.2 Renaming a Space Folder 
To rename Space, first you need to shut down the TeamDrive client. After the client has been shut down, rename 

the Space folder, in the file system, and start TeamDrive. 

Upon starting, TeamDrive will recognize that the location of a Space folder has changed and will ask you for the 

new location of the Space folder. Browse to the newly named Space folder, select it and that’s it! Your Space folder 

has now been renamed. 
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Relocating/Renaming a Space folder 

 

 

3.8 Re-inviting a User 

In some cases you may often need to invite the same user to a Space over and over again. The reasons for this can 

of course vary: the user left the Space by accident, the user has a new TeamDrive installation, etc.. Instead of going 

through the entire invite process using the Invitation Wizard you can simply right-click on the desired user and 

select “Re-invite User To Space”. If you click on the “Spaces” tab the users will be displayed on the right side of 

the screen in the “Members” window. If you are on the “Members” tab you will see a list of all members in your 

address book. When the invitation has been sent you will receive an ‘invitation sent’ notification as usual and the 

user will receive an invitation to the Space.  

 
 

Re-inviting a user to a Space 
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4 The TeamDrive Explorer 
 

4.1 The Spaces View 

The “Spaces” view is the default view of the TeamDrive Explorer. Virtually all of the TeamDrive functions can be 

called up from here (i.e., creating Spaces, inviting members, etc.). First, select a Space of your choice, then either 

select “Space” on the menu bar or right-click on the Space name, or icon, to execute actions for the selected 

Space. 

The context menus provide commands to manage your Spaces. Some of the settings in the context menus can 

only be used with an active Internet connection. If you are not connected to the Internet, you will receive error 

notifications. The commands from the context menus can also be found in the TeamDrive Explorer menus. Once 

you click on a Space, more information about the Space is shown in the windows on the right. 

 
 

Spaces View 

 

 

4.1.1 Black Circle Overlay (Black Dot) 
 

The transfer of data on a server includes the exchange of metadata and the actual data. The metadata (the 

contents and context of data files, i.e.: filenames, modification date, etc.) is usually the first data that is sent to and 

received from a server. So, before your TeamDrive client actually downloads the actual data, the metadata is al-

ready on your computer. 

With the metadata you have the details of the file, however, the file is not actually in your file system yet. Here is 

where the black circle overlay (black dot) comes into play. The black circle overlay symbolizes that the metadata of 

that particular file has been received, BUT the data has not yet been downloaded to your file system. The down-

load will usually take place after a short moment or is already in progress. If TeamDrive has not downloaded the 

data after an extended period of time (or if you do not have time to wait for TeamDrive to retrieve the data) right-

click on the file, or the Space folder, and select “Restore Missing Files”. The file, or all files (if you clicked on the 

Space folder) with the black circle overlay will then be retrieved from the server and fully synced with your client. 

You may not always know when files have not been retrieved from the server. TeamDrive does not alert you to this 

situation. Files with the black circle overlay are usually noticed while going through Space folders. There is a sim-

ple way to locate all files that have a black circle overlay. 
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In the ‘search’ bar (while on the “Spaces” tab), change the filter (the arrow pointing down under the magnifying 

glass) setting to “Missing Files”. All missing files in all Spaces (if any) will then show up where your Space folders 

previously were. 

  
Black Circle Overlay: Show only missing files Black Circle Overlay: Restore missing files 

 

4.1.2 Managing Versions 
 

TeamDrive uses a file versioning system, which creates new versions of a file instead of overwriting the original file. 

By default, all file versions are stored on the server. File versioning is managed on a per Space basis. This means 

that the number of version to be kept for a file depends on the version settings of the Space the file is in. During 

the creation of a Space you have the ability to select how many versions of files contained in the Space will be 

stored on the server. Again, by default, all versions are kept on the server. 

Individual versions can be manually deleted by right-clicking on a version in the version tree and selecting “De-

lete”. It is only possible to delete a file version when it is not set as the current version. 

 
 

Managing Versions: Deleting a single version 
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With a Professional license it is possible to change the version settings of a Space even after a Space has been cre-

ated. This can be done by clicking on the Space and clicking on “Advanced” on the right in the window “Space 

Information”. Scroll down to “Number of versions to be kept on server” and alter the number of versions to be 

stored on the server. 

  
Managing Versions: Select versions during Space creation Managing Versions: Change number of versions for a Space 

 

4.1.3 Managing the Trash 
 

Each TeamDrive Space has its own respective trash can. All files in the trash remain on the server until the trash is 

emptied. The number of files currently in the trash can be seen in the window “Space Information” under the 

section “Advanced”. You do not see, however, how much Space on the server the files in the trash occupy. The 

value displayed next to “Size” represents the total size of file versions, residing in that Space, currently stored on 

your machine. To empty the trash, right-click on the trash of a Space and select “Empty Trash”. All files in the trash 

can will then be permanently deleted from the server. It is only possible to empty the trash can if you have admin-

istrator rights in a Space. 

With a Professional license it is also possible to have the trash emptied automatically after a set amount of time. 

The options range from “never”, “180 days”, “90 days”, “60 days”, “30 days”, “14 days” and “7 days”. These set-

tings can be found in the window “Space Information” under the section “Advanced” > “Delete files from trash 

after”. 
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Managing the Trash: Emptying a Space’s trash Managing the Trash: Setting trash to automatically empty itself 

 

 

4.1.4 Icon Descriptions 
 

 

 

The user in the Space 

The icon representing you. 

 

Space Member 

Normal Space member. 

 

Invited Member 

A member who has been invited to the Space but has not yet joined. 

 

Unknown User 

A user who does not have a TeamDrive account yet. This icon could be seen if 

a member has been invited via email. 

 

By right-clicking on a member, you can view user-related options such as changing user rights (If you have the 

rights to do so). 
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4.2 The Activity View 

The “Activity” view has two windows: the messages window and the upload/download list window. Both win-

dows have status indicator icons. After making a selection, the corresponding status is shown in the “Messages” 

window under “Status”. The two windows display the status of data transfers (sending/ receiving). The messages 

window displays live upload/download progress while the list window simply displays the file’s upload/download 

status. This allows you to easily monitor the transfer of data. 

 

 
Activity View 
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4.2.1 Event Messages 
These icons and their descriptions are displayed on the following page(s). 
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4.2.2 Logging Out of TeamDrive 
 

At any given time you have the possibility to log out of TeamDrive on your local machine. To log out of TeamDrive 

select “File” > “Quit and Logout”. The current user account will then be logged out on that machine. Logging out 

of TeamDrive gives another user the possibility to login with their TeamDrive account on the same machine. You 

also have the possibility to register a new TeamDrive account. After you have logged out of TeamDrive, start the 

application again. When TeamDrive starts you will see the same login screen you normally see when you first in-

stall TeamDrive and start it for the first time. At this screen you can register, login with a new user or login with 

your usual account. 

 
 

Logging Out of TeamDrive 

 

 

4.3 The Members View 

In the “Members” view you will be see an overview of which users are members of which Spaces. Also, users who 

are no longer members of Spaces you are a member of are also displayed here. To remove a user from this list, 

right-click on the user and select “Delete User from Addressbook” (a member can be deleted from your address 

book if and ONLY if the user is no longer a member of any of the Spaces you are a member of). 
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Members View 

 

4.3.1 Changing Member Rights 
 

The “Spaces” view has three windows. After selecting a Space, all members in the Space are displayed in the 

“Members” window. Right-click on a member whose rights are to be changed. Select “Change Rights” from the 

context menu and apply the desired user rights. The change is then synchronized with all clients connected to the 

Space. Members can be modified only by users with administrator rights. 

 
 

Changing Member Rights 

 

4.3.2 Removing a Space Member 
 

The “Spaces” view has 3 windows. After selecting a Space, all members in the Space are displayed in the “Mem-

bers” window. Right-click on the member you wish to remove from a Space. Select “Remove User” from the con-

text menu to remove the member from the Space. Once a member is removed from a Space re-entry into the par-

ticular Space (without receiving a new invitation to the Space) is not possible, even if the deleted member at-



 

 

 

© 2014 TeamDrive Systems GmbH Page 27 

tempts to restore the Space using their backup file. Members can only be removed by users with administrator 

rights. 

 
 

Removing a Space Member 

 

4.4 Server Selection 

There are two different protocols that can be chosen when establishing a connection to a server. 

 

If you wish to use TeamDrive to manage larger amounts of data and/or a large num-

ber of users and to optimize the speed of data transfers between members, as well as 

data security, you will probably want to use TeamDrive HTTP- servers. These servers 

use the HTTP protocol and port 80. 

 

 

• This is a good protocol if you are using a firewall. 

• You have the option of using proxy-servers. 

• Easy accessibility can be ensured via monitored servers. 

 

 

This protocol is pre-set after installation 

 

A WebDAV server provides all users with a standardized working environment. 

TeamDrive can make working with these servers significantly more comfortable and 

secure. No passwords or access data have to be sent to your own WebDAV server and 

all data on the server is automatically encrypted. 

 

 

• No server installation is required. 

• TeamDrive is the best client for any WebDAV server. 

• WebDAV access information needs to be set only once. 
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Note: 

The login information for WebDAV servers will not be transferred in encrypted form when an HTTP transfer takes 

place. Unauthorized access to your TeamDrive data is still not possible, however, because TeamDrive itself heavily 

encrypts data (256-bit AES) before it is transferred to a server. Protocol-wise, there is a theoretical possibility of 

third party access to the WebDAV login information. The data TeamDrive stores on the server, nevertheless, re-

mains untouchable. 

Within the TeamDrive client you can configure WebDAV servers via HTTPS which means that even the login infor-

mation will be encrypted. 

 

4.5 Versions Comments 

TeamDrive also offers you the ability to leave ‘version comments’. Comments can consist of anything. For exam-

ple, a reference made to the processing status of a shared document: “50% completed”. Comments, and the ver-

sion number the comments are related to, are displayed when the file is selected. Comments can be easily dis-

patched via email to Space members depending on the license you have. 

  
  

Version Comments: Add a comment Version Comments: Entering a comment 

 

A maximum of 140 characters are allowed in the text-box. If you decide to share the comment via email (Profes-

sional license) please note that the comment will be transmitted in an unencrypted form. 
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Version Comments: Viewing a version comment 

 

 

To delete a version comment simply click on the trash can in the comment window. Click “Yes” to confirm the de-

letion of the comment. 

 
 

Version Comments: Deleting a comment 
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4.6 Publishing a File 

The ability to publish a file to the web is available depending on the license you have. Right-click on the file you 

would like to publish and select “Publish Version” from the context menu (this action can also be carried out 

through the “Edit” menu on the menu bar). A new window will open displaying the generated URL. 

  
  

Publishing a Version Publishing a Version 

 

By selecting “Publish” the file will be uploaded to the server in an unencrypted form. This function cannot be used 

with WebDAV servers. The file’s address can also be dispatched via email. To ‘unpublish’ a file, first navigate to the 

desired file in TeamDrive. Looking in the version tree, find the version of the file that has been published, right-

click on the file and select “unpublish”. Published files can be quickly found using the search filters. You can find 

more info on search filters in the section “The Spaces View”. 

 
 

Publishing a Version 
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4.7 Conflicts 

4.7.1 Version Conflicts 
 

Version conflicts can occur when a file is simultaneously in use by multiple parties and a new version for the file is 

saved and uploaded from two separate locations. It is also possible to have version conflicts with a single user if 

he/she has multiple installations.  

  
Version Conflicts Version Conflicts: Filtering for conflicts 

 

An easy way to find files marked with the red ‘conflict’ overlay is to use the filter function. There is a filter function 

on every tab (Spaces, Members, Activity) but you should use the filter on the “Spaces” tab. Just below the “Spac-

es” tab you will see a magnifying glass with a text field to the right of it. Click the dropdown arrow next to the 

magnifying glass and select “Conflicts”. All files labeled with the red ‘conflicts’ overlay will then be sorted. 

From there you can select which version should be the latest version and TeamDrive will recognize the changes 

and continue to sync the file as normal. 
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Version Conflicts: Resolve conflict Version Conflicts: Choose version to use as current version 

 

 

4.7.2 Name Conflicts 
 

In the event that TeamDrive no longer syncs due to files having too long file/path names, or there are two files or 

folders in a Space that have the same name, you simply need to find the files/folders and rename them. 

  
Name Conflicts Name Conflicts: Filtering for conflicts 

 

An easy way to find files marked with the red ‘conflict’ overlay is to use the filter function. There is a filter function 

on every tab (Spaces, Members, Activity) but you should use the filter on the “Spaces” tab. Just below the “Spac-

es” tab you will see a magnifying glass with a text field to the right of it. Click the dropdown arrow next to the 

magnifying glass and select “Conflicts”. All files labeled with the red ‘conflicts’ overlay will then be sorted. 

From there you can rename the files/folders and TeamDrive will recognize the changes and continue to sync as 

normal. 

5 Settings 

5.1 General Settings 

In the toolbar under “Extras” � “Settings…” you can reach all the settings of the TeamDrive client. The “Auto-

start” function allows TeamDrive to start automatically after the start of the computer. If you do not wish to have 

TeamDrive start automatically you need to uncheck the “Autostart” box. 

The Total working set size is the maximun size of the folder where TeamDrive temporarily and permanently 

stores data necessary to work and function properly. As a general rule of thumb TeamDrive needs at least double 

the size it attempts to synchronize and it is recommended to use around triple that size. This is why the default 

value is 5 GB with our free 2 GB account. With that you could e.g. synchronize one 2 GB file or two 1 GB files if you 

are so inclined. 
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Upon installing TeamDrive a path for the database and the required cache is defined. The default path is located, 

on Windows, on the ‘C’ drive. If the database and the cache location need to be changed for any reason, the new 

path can be selected here. Once you have changed the file path to where you want the database to be stored, a 

short notification stating “Data location will be moved on restart” will appear. 

Here you also have the ability to change/select the display language for TeamDrive. The current available lan-

guages are: English, Finnish, French, German, Norwegian and Spanish. 

 
 

Settings: General 

 

5.2 Registration 

Here you have the ability to change your registration email address. Simply type in the new email address you 

would like to use and click “Change”. 

If you have forgotten your password please select “Forgotten” in the “Change Password” section. You will then 

see a notification indicating that a temporary password has been sent to your registered email address (be sure to 

check you SPAM folder for the email). Enter the temporary password in the required field and then enter your new 

password. The password must be at least 8 characters long and may contain special characters, but no spaces. 
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Settings: Registration 

 

5.3 Space Settings 

Here you can change the default Space location and disable the scan of Spaces in the file system on startup. 

TeamDrive’s default setting is to scan the Spaces in the file system on startup. Here, that can be disabled. To disa-

ble this function check the “Disable Scan of Spaces in File System on Startup” box. Once selected, TeamDrive 

will no longer scan the Spaces in the file system when the application starts. 

The default storage location for your Spaces can also be changed here. To change the location as to where Spaces 

are stored, click the “...” button on the right and browse to the folder where you wish to store your Spaces. 

 
 

Settings: Space 

 

 

5.4 Backup 

Here you can decide whether to backup server and Space access information. By default, TeamDrive creates back-

ups of server and Space access information. This can be disabled here by unchecking the “Backup Server and 

Space Access Information” box. 

You can also define the location of where your Space and server access keys are saved. By default a “Backups” 

folder is created in your “Spaces” folder. You can change the storage location of your backups at any time. For 

more information on data backup, please see the section “Data Backup”. 
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Settings: Backup 

 

 

5.5 Server Access (Adding Additional Servers) 

Your server information is displayed here. If you have more than one server available for use you can also set the 

default server here. The options to import, export and add a WebDAV or TeamDrive Personal Server are also avail-

able on this tab. Only server files ending with *.tdsv, *.sakh, *.sakhs, *.sakw, *.sakws and *.sakp can be import-

ed. When exporting a server, servers are exported as *.tdsv files. There is also the possibility to remove a server 

(the ability to add a WebDAV server depends on which license you are using: Free, Personal or Professional). 

 
 

Settings: Server 
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5.6 Proxy Settings 

If necessary, a proxy can be setup on this tab. We have also added the ability to setup an automatic proxy configu-

ration URI using PAC files. A Proxy Automatic Configuration (PAC) file is a file that acts as a URL or site routing 

control file for a web browser. Simply put: The PAC controls how the browser retrieves an object - directly, bypass-

ing the proxy or via a proxy. The PAC can also return different proxy servers based on conditions found in the file. 

 
 

Settings: Proxy 

 

 

5.7 Permissions (Professional license) 

TeamDrive offers the ability to create new roles and apply custom “Member Actions”, “Space Operations” and 

“File Operations” permissions to them. You can also delete roles here. However, you can only delete roles you 

have created. The default roles cannot be deleted. Default roles include Administrator, Superuser, Read/Write, 

Read and Read (Anonymous). Full descriptions of the privileges of each role can be found in the TeamDrive client 

in the Permissions section. 
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Settings: Permissions 

 

5.8 Notifications 

The Notifications tab allows users to configure TeamDrive’s built in notification system. Here you can decide if 

you would like TeamDrive to notify you about conflicts and errors, invitations and members, files and versions 

and comments. With a Professional license you can even elect to be notified about conflicts and errors via email. 

You can also configure in which corner of the screen the pop-up notification should appear (and on which screen 

if you are using multiple monitors), the duration of the pop-up notification, if you would like to be reminded that 

you have received pop-up notifications and the maximum number of notifications that can be seen on-screen at 

once. Once the max notifications has been reached, the notifications are grouped into their respective categories 

and a general message is displayed. 

 
 

Settings: Notifications 

 

6 Data Backup 
 

The access key(s) for your Space(s) are stored on your local client so they should be carefully protected. It is possi-

ble to store encrypted backups of your access key(s) on the server using the “Key Repository”. By default, the “Key 

Repository” is enabled. If you elect to continue using the Key Repository, encrypted backups of your keys will be 

stored on the server which will allow you to regain access to your Spaces after you have created new installations, 

have had a hard drive failure, etc. More information regarding the Key Repository, and how to disable it, can be 

found in the section “Key Repository”. If you elect to disable the “Key Repository”, the access key(s) for your 

Space(s) will only be stored on your local machine. With that said, they should be carefully protected as they are 

one of your only means of regaining access to your Spaces! 

 

6.1 Regaining Access to Your Spaces 

In the event that your device crashes, your device is lost or stolen, you install a new hard drive, you create a new 

TeamDrive installation on a new device, etc. you will, of course, need to regain access to your Spaces. If you have 
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the “Key Repository” enabled you should automatically receive invitations to your Spaces. If it is not enabled you 

will need to refer to “Importing a Space” as well as “Restoring and Activating a Space” or simply refer to “Joining 

(or Recovering) a Space” via an invitation. You can also use “Inviting Yourself to Your Previously Created Spaces” or 

“Inviting Users and Accepting Invitations”. 

 

6.2 Space Access Keys 

A backup file (containing the Space access keys as well as the access keys to the servers the Spaces are stored on) 

is generated each time a new Space is joined or created. For security reasons they are tied to the activation of the 

member. The key entries enable the restoration of a Space. 

 

6.3 Server Access Keys 

For every server, a server access key is required. This allows users to restore access to the necessary servers. Server 

access keys are generally stored, in conjunction with the Space access keys, in the TeamDrive backup files. Server 

access keys can also be individually imported and exported via the TeamDrive client. 

 

6.4 Backing up Space and Server Access Keys 

Under “Settings” > “Backup” > you can define the location of where your Space and server access keys are stored. 

By default a “Backups” folder is created in your “Spaces” folder. You can change the location of the backup at any 

time. 

 
 

View backup directory in TeamDrive 

 

We recommend, if possible, saving your access files to an external storage device. So, in the event of a complete 

system crash, you can still restore your TeamDrive Space(s) and the connection(s) to your server(s). It also enables 

you to set up TeamDrive on another computer. 
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Note: 

Passing on Space information to third parties is pointless, as Space information is specific to your account. 

For file system storage purposes the backup’s filename contains your username and a timestamp. To restore a 

Space or access to a server from a backup, the backup file must be imported. Once the backup file has been im-

ported the Space(s) can be restored. 

 
 

‘Backups’ folder in file system 

 

6.5 Key Repository 

The Key Repository allows you to store encrypted backups of your Space keys on the server. This is useful in the 

event that your device crashes, your device is lost or stolen, you install a new hard drive, you create a new 

TeamDrive installation on a new device, etc., and you do not have access to your backup files. By default, the Key 

Repository will be enabled. To disable the Key Repository please select “Disable Key Repository”. By that all keys 

stored on the server will be deleted. If you decide to re-activate the feature again in the future all keys to all Spaces 

that you currently have on the device you are activation the feature on will be uploaded again after you create a 

Space event like creating or deleting a Space. 

 

When enabled, the Registration Server Key Repository stores the keys to all your Spaces. The Key Reposito-

ry is encrypted with your password, and can only be accessed by you, after a valid login. 

When in use, the Key Repository serves as a backup for your Space keys, and it also ensures that you have 

access to your Spaces when you login to TeamDrive on a new/different device. 

The Key Repository can be accessed as long as you remember your password, or have a valid login on one 

of your TeamDrive devices. 

 

With the Key Repository enabled you will automatically receive invitations to Spaces you have previously joined, 

after you have created a new TeamDrive installation. In the event you do not receive invitations to all of your 

Spaces, you can manually import the remaining Spaces by selecting “Import” in the “Key Repository” area of the 

“Backup” section on the “Settings” panel. 
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Settings > Backup > Key Repository 

 

 

6.6 Restoring and Activating a Space 

In the event that you have left a Space locally, reinstalled TeamDrive or your operating system or simply wish to 

use your TeamDrive account on another computer (such as a notebook), you can use the corresponding backup 

files  (*.tdbk) to import and restore the Space. Detailed information regarding importing Spaces is outlined in the 

section “Importing a Space”. 

 
 

Restoring a Space 

 

Exceptions: If the Space has been removed from the server (and the SpaceDepot server) restoration is no longer 

possible. An administrator can revoke a member’s access to data by removing the member from the Space. All 

data from this Space on the member’s computer will be erased the next time an Internet connection is estab-

lished. The restoration of the Space will not be possible for this member. 
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Upon importing a Space using a backup file (section “Importing a Space”), the Space will have the same appear-

ance as that of an archived Space (‘greyed’ out). To begin the Space restoration process right-click on the Space 

and select “Restore Space”. When restoring the Space data, the data can be downloaded completely from the 

server, restored from the existing Space folder on your machine or copied or moved from any other existing folder 

on your local machine or an external hard drive. To view and select one of these options click the “Advanced” 

button. You will then see a drop down menu with the options, “copy files from backup”, “copy files from speci-

fied path”, and “move files from specified path”. Select the desired option, and file path if necessary, and click 

“Restore”. 

  
Restoring a Space: Join mode Restoring a Space: Copy/Move files from an alternate location 

 

Members who have been deleted from a Space are not able to restore the Space using their backup file. Once a 

member is removed from a Space, re-entry into the particular Space (without receiving a new Space invitation) is 

not possible, even if the deleted member attempts to restore the Space using their backup file. 

 

6.6.1 Cancel Recovering a Space (Archiving a Space while Recovering) 
 

While recovering a Space it is possible to cancel the recovery process. This will actually archive the Space and allow 

you to recover the Space at your earliest convenience. To cancel recovering a Space, right-click on the Space dur-

ing the recovery process and select “Cancel joining Space…”. This option, however, will not become available 

until the events of that Space have begun to be downloaded. Once TeamDrive has begun downloading the fold-

er’s events from the log, it is possible to cancel joining the Space. 
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Cancel Recovering a Space 

 

6.6.2 Archiving a Space 
 

TeamDrive allows you to archive Spaces at your leisure. If, for example, a project has been completed and the data 

on the local disk is no longer needed, the data can be safely and securely archived for later use. To archive a Space, 

either right-click on the Space and select “Archive Space” from the context menu or select “Archive Space” from 

the “Space” menu on the menu bar while the Space is selected. 

 
 

Archiving a Space 

 

Afterwards, you will see a prompt asking whether you would like to remove the data stored locally in the file sys-

tem. If nothing is checked, the data will remain in the file system. Once a Space is archived the data remains on the 

server at all times. 
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6.7 Importing a Server Access Key 

A “Server Access Key” can be imported by navigating to the “Settings”/“Preferences” window and selecting 

“Server Access” > “Import Server...” and selecting the file containing the server access key. 

 
 

Importing a Server 

 

6.8 Importing a Space 

In the event that you have left a Space locally, reinstalled TeamDrive (or your operating system) or simply wish to 

use your TeamDrive account on another computer (such as a notebook), you can use the corresponding backup 

file to import the Space. 

 
 

Import a Space from a backup file 

 

To import a Space, navigate to the “Backup” tab in the “Settings/Preferences” area. If you have your backup files 

handy you can select “Import from Backups...”, and choose the desired backup file(s) (you have the ability to se-
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lect multiple backup files at once) you would like to import. If you do not have your backup files available to you, 

and you have the “Key Repository” turned on, you can use the “Import” button from the Key Repository section 

below. A dialog will then appear listing all Spaces that can be imported from the backup file(s) you have selected.  

 
 

Import a Space from the Key Repository 

 

By default, all Spaces will be checked. To deselect all of the Spaces right-click and select “Select None” or deselect 

“All”. To select all, check the “All” check-box or right-click and select “Select All”. “Import Servers” and “Import 

Address Book” are also checked by default. They contain your server information and all members who appear 

under the “Members” tab. When you are finished selected the Spaces to be imported select “Import”. The Spaces 

will then appear under the Spaces tab, ready to be restored.  

 
 

Space imported 

 

Detailed information regarding restoring and activating a Space is outlined in the section ”Restoring and Activat-

ing a Space”. 
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6.9 Deleting a Space 

To delete a Space, right-click on the Space, or click on “Space” on the main menu toolbar and select “Delete 

Space…”. 

 
 

Deleting a Space 

 

To delete the Space locally, check “Delete the Space folder”. To delete the Space on from the server, check “De-

lete Space on Server”. To delete the Space both locally and on the server, check both boxes. Checking nothing 

will remove the Space from the “Spaces” view of the TeamDrive client. The Space won’t be synchronized anymore 

and you leave the Space but it will still exist locally and on the server. 

 
 

Deleting a Space locally, from the server or only from the TeamDrive client 
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7 Document Protection and Encryption 
 

Document protection and encryption is managed automatically by TeamDrive, allowing the user to concentrate 

on the actual exchange of data within the virtual network. Thanks to automatic version control, it is always easy to 

tell which document represents the most recent version. Attached to every version is information detailing the 

author, version, the preceding version, and the date it was last edited. In addition, a comment can be attached to 

every version. With the ‘version timeline’, you can view all versions of a document, follow the changes made, and 

resolve conflicts between versions. 

 

Note: 

At no time during the exchange of data via TeamDrive does non-encrypted data reside on the 16 TeamDrive First 

Steps network. All documents are encrypted before being sent to and saved on the server. The decryption of this 

data is only possible for team members and cannot be done on the server. This way, TeamDrive guarantees opti-

mal protection for your team’s documents. 

 

Even though other techniques (for example email with PGP encryption, VPN) enable the secure transfer of data, 

these methods are complex, time consuming and are too error-prone to be used on a regular basis. TeamDrive 

automatically integrates data encryption into the work process without requiring any user interaction. This is the 

only way to ensure comprehensive data protection. 

 

Note: 

The excellent data protection capabilities of this technology make TeamDrive the ideal tool especially for lawyers, 

financial advisers, researchers, scientists and the medical community. TeamDrive not only makes exchanging data 

fast and easy, it also makes it very secure. 

 

All local data, including earlier versions, comments and status information is archived on the server by TeamDrive. 

 

7.1 Security 

The individual client PC or USB device should be adequately protected from third party access. TeamDrive 

is not security software for the PC or your mobile device. All data sent by TeamDrive will be highly encrypt-

ed before it is actually sent. Local data on your personal device will, most of the time, be unencrypted. In 

addition to standard security policies like boot passwords, TeamDrive can be installed and run on encrypt-

ed partitions or containers to increase the security (i.e. TrueCrypt or PGP encrypted volumes). In regard to 

this, we recommend reading the security tips in this handbook. 

It is important to have a basic understanding of the security requirements of your own computer or any IT or net-

work infrastructure that you use. Security and reliability are two major features of TeamDrive. All actions taken by 

the TeamDrive client are highly secure and protected from external access. Most actions take place automatically 

or are available to the user via the controls. 
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Note: 

We recommend viewing the information provided by the BSI 

(https://www.bsi.bund.de/EN/Home/home_node.html) for more information on this topic. 

 

Due to potential security threats and the increasing reliability on IT security measures, all institutions (large or 

small) have to find a solution for several essential security concerns. The following is our position on the aspects of 

security directly connected to TeamDrive. 

 

Note: 

TeamDrive takes no responsibility for the security of data on your computer or your server, but guarantees, how-

ever, the security of data uploaded and downloaded within the TeamDrive network. 

 

7.2 Encryption 

The encrypted transfer of data is TeamDrive’s underlying security feature. The encrypted exchange of data classi-

fies itself into three steps: 

Step 1: When a member is invited into a Space the TeamDrive software receives the public key from the registra-

tion server. 

Step 2: In order to access a (shared) Space, a ‘data-key‘ (256-bit AES key) is created locally and encrypted with the 

member’s public key. It is then sent to the member via a private communication path. At no time is this key locat-

ed on a relay server. 

Step 3: Before your data leaves the client PC, the Space’s data is encrypted using your data key. This data is then 

saved on a relay server in an encrypted form. The encryption is such that the Space’s data can only be accessed by 

the Space’s members. Since every member has their own key, they are authorized and can receive data from the 

Space. This data is then decrypted using their data-key and can then be viewed or edited locally on their machine. 

7.3 Anti-Virus Software 

TeamDrive data stored on a computer is guarded by the local antivirus software. The software tests the relevant 

file when the TeamDrive database is accessed. Your current antivirus software should always guard all Spaces in 

your local file system. 

 

Note: 

We recommend having your own local antivirus software. Every TeamDrive user quickly acquires many Spaces and 

files (files potentially accessed and/or edited by every member of the Space) with various different teams. Self-

protection is the safest method! 

 

 

https://www.bsi.bund.de/EN/Home/home_node.html
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7.4 Notice Regarding Secondary/Log Data 

Personal data saved as files within a Space can be permanently deleted, together with all their contents, by a 

member of the Space with administrator privileges. The names of the files remain in the Space log file for as long 

as the Space exists. 

Every user who creates a Space is, by default, the owner and administrator of the Space. If this user deletes the 

Space from the server, all of the data in the Space, including the log file with all its contents, are deleted (all prima-

ry and secondary data are deleted). 

If a member leaves a Space, all information in relation to that member (e.g. membership, joining the Space, leaving 

the Space, which data they edited, etc.) is kept within the log file. The log file will not be deleted as long as the 

Space exists. If, for example, if a member who is leaving a Space insists that all of their data be deleted, the Space 

itself must be deleted. If you wish to retain the data in the Space added by other Space members the data must be 

backed up before the Space’s deletion, a new Space must be created and the data must be moved into the new 

Space. 

 

 

7.5 Notice to Companies Required to Store Confidential Data 

TeamDrive is designed to store and share confidential data and information. The encryption methods and tech-

nologies used by the TeamDrive client safeguards all data from being accessed by unauthorized third parties. 

Unauthorized access to your data can only be initiated by the user. For example, wrongfully assigning user access 

rights to a Space. 

We recommend, to companies required to store confidential data, using password protection, for example, when 

sending Space invitations. Protecting your invitations with passwords add an additional level of protection and 

require the invited user to enter the given password before they can accept the invitation. We advise using a 

password which contains numbers and upper/lowercase letters. 

 

 

8 Tips Regarding Data Protection and Administration 
 

TeamDrive’s compliance with data protection regulations is recognized by companies and institutions. In order to 

enable optimal compliance with data protection regulations, the following advice regarding installation and use 

of this product should be followed. 

The individual client PC should be adequately protected from unauthorized third party access. Regarding this, we 

suggest reading the “Document Protection and Encryption” section of this handbook. 

Required for the use of TeamDrive is that personal information must be sent to the product manufacturer’s regis-

tration server. The requirements are an email address, a username and a password. The transfer of this data to the 

registration server is encrypted, rendering access by a third party impossible as of the current state of technology. 

Please be aware that protocol data, as well as data stored in a Space may be subject to legal restrictions. It is the 

user’s responsibility to make sure that any such restrictions are followed. 
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It is the administrator’s responsibility to ensure that all laws and regulations regarding the proper use and protec-

tion of data are observed while using TeamDrive. 

In cases where this product is used without an internal data Space Depot, contracts with the provider of the Space 

Depots need to be observed. Here, there are no differences compared to other IT products that use an external 

database. The contractor has to be carefully chosen and written instructions 

must be provided. Further information regarding this can be found at 

http://www.datenschutz.de/privo/partner/projektpartner/. You can also con-

tact us for further help. We can also provide contacts, if you wish to set up an 

external server. 

When using the default cloud services for data storage of TeamDrive in Eu-

rope, data is stored automatically on servers in Europe. This automatic disk 

space allocation of users during the registration is based on their IP address 

during registration. The server mapping is not changed later, no matter 

where the user is located in the world. TeamDrive can the server mapping at 

the informal request of the user by email to support@teamdrive.com. The 

server URL of any space can be seen in the Space’s detail view in the 

TeamDrive Explorer. All TeamDrive cloud URLs pointing to European servers 

have “EU“ in their URL.  

Img. 40: Space information in the inspector 

8.1 Notice Regarding Secondary Data/Log Data 

Personal data saved as files within a Space can be permanently deleted, together with all their contents, by a 

member of the Space with administrator privileges. The names of the files remain in the Space log file for as long 

as the Space exists. 

 Every user who creates a Space is, by default, the owner and administrator of the Space. If this user deletes the 

Space from the server, all of the data in the Space, including the log file with all its contents, are deleted (all 

primary and secondary data are deleted). 

If a member leaves a Space, all information in relation to that member (e.g. membership, joining the Space, leaving 

the Space, which data they edited, etc.) is kept within the log file. The log file will not be deleted as long as the 

Space exists. If, for example, if a member who is leaving a Space insists that all of their data be deleted, the Space 

itself must be deleted. If you wish to retain the data in the Space added by other Space members the data must be 

backed up before the Space’s deletion, a new Space must be created and the data must be moved into the new 

Space. 

 

8.2 Notice to Companies Required to Store Confidential Data 

TeamDrive is designed to store and share confidential data and information. The encryption methods and tech-

nologies used by the TeamDrive client safeguards all data from being accessed by unauthorized third parties. 

Unauthorized access to your data can only be initiated by the user. For example, wrongfully assigning user access 

rights to a Space. 

We recommend, to companies required to store confidential data, using password protection, for example, when 

sending Space invitations. Protecting your invitations with passwords add an additional level of protection and 

require the invited user to enter the given password before they can accept the invitation. We advise using a 

password which contains numbers and upper/lowercase letters. 

http://www.datenschutz.de/privo/partner/projektpartner/
mailto:support@teamdrive.com
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